
WWell, it’s time for me to
address the member-
ship in an article for

the spring Ad Infinitum. I have
to admit that writing articles as
president was something that
made me a little uneasy, since
I’m certainly no author. Fortu-
nately, in the past I have been
inspired by some topics and the
words just flowed. In this edi-
tion, I thought we’d chat about
some of the goings on in the
state over the last few months.

Spring is in the air and it’s
time for career events at area
high schools. This is a prime
opportunity for ILCRA to step
forward and spread the word
about the viable careers that
come out of our profession. I
think at one time or another dur-
ing our own schooling, we’ve
come across a naysayer espous-
ing untruths about the demise of
court reporting as we know it.
With the advent of certain tech-
nologies, it gives these people
further fodder to predict our
demise. Fortunately, we have
embraced technology and it has
opened new doors and new
career paths for people with
steno machine skills. A court
reporter can go to a courtroom
and create a verbatim record, to
a deposition suite and provide a
realtime feed to attorneys, to a
classroom or a board room and
provide communication access
for a deaf or hard of hearing par-
ticipant, or never leave the house
and provide broadcast captions
for millions of Americans all the

while wearing the proverbial
bunny slippers. How can this not
be a viable career option?

We personally need to spread
the word about court reporting.
We simply can’t rely on career
counselors or next door neigh-
bors. When ILCRA gets notified
of the opportunity to participate
in a career event, we make every
attempt to do so. Sometimes it’s
board members that attend.
Sometimes we are able to recruit
the membership to help as well. I
would like to personally thank
the following ILCRA members
for using their valuable free time
and volunteering on our behalf
to promote the profession of
court reporting over the last few
months: Melissa Clagg who
attended the 8th Grade Career
Conference in Savoy in January,
Georgia Rollins and Kathryn
Thomas who attended the 8th
Grade Career Conference at Lake-
land College in February, and
Jackie Timmons and Judy Mosier
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Lyn M. Grooms, Chair; Robert Griffith – ORS, LeAnn M. Hibler, 
Jackie Timmons and Rose LaBerdia
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Seymour Wolfe, Chair; Dee Doubet, and Judy Lehman

Elections Committee: To be activated when necessary
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Mary Beth Rollins, Chair; Patricia Byers, Nancy C. Davis, and Lyn
M. Grooms

PR/Marketing Committee: 
Jackie Timmons, Chair; Kris Ashenhurst, Judy Mosier, Georgia
Rollins and Kathryn Thomas

Speed Contest Committee: 
Bonni R. Shuttleworth, Chair; Teri Gaudet and Theresa Hovick-Thomas

Student Scholarship Committee: 
Bernice Radavich, Chair; Nancy McClarty, and Retha Meyerhoff

Student Mentor Chair: Jill M. Layton
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who will be attending a confer-
ence of the Illinois Association of
College Admission Counselors in
May. Also, I understand that
Brenda Engele along with
Stephanie Rennegarbe were
ready to volunteer at Nashville
High School’s career event but,
unfortunately, this year there
were no students interested in
the profession. I, too, attended a
career night at Maine High
School in March where an esti-
mated 2,000 students and par-
ents attended. Also, in April,
Romeoville High School has a
career event which I will attend
unless Catherine Rajcan volun-
teers for me which she did last
year. So, again, “thank you” one
and all on behalf of the court
reporters in Illinois for taking
time and sometimes money out
of your day in order to promote
what is one of the greatest pro-
fessions out there.

ILCRA also has been actively
working towards the passage of
a piece of legislation in Illinois
that will remedy an unintended
pay cut for the state’s official
court reporters which occurred
when the governor made his
budget cuts last fall. I’ve been
very pleased at the grass roots
efforts made by many reporters
in our state. I especially want to
thank Joan McQuinn, Chairper-
son of ILCRA’s Officials Commit-
tee. As part of Joan’s duties I
have asked her to send out mass
emails to a group of official
reporters we call “Circuit Reps.”
These call-to-action emails are
ILCRA’s way of contacting the
state’s official reporters and
alerting them of the need to call
legislators and ask for their sup-
port for our bills. To all the Cir-
cuit Reps who are also ILCRA

members, “thank you” for tak-
ing the time to pass the word
along. Without your help, we
surely would not be as successful
as we have been with the legisla-
tion thus far.

Unfortunately, this year Illi-
nois had to experience its own
college campus shooting. My
heart goes out to all of those
affected by the Northern Illinois
University shooting. I didn’t
know anyone personally that
was injured or killed, but I do
know some of the CART
providers that are on the NIU
campus on a daily basis. This
world can be very unpredictable,
and, unfortunately, our profes-
sion can literally place us in the
line of fire. I have asked ILCRA
members Becky Dawson, Ann
Pellican and Pam Wixom to
write articles and share with the
rest of us their experiences about
that fateful day and how it has
affected them. (See their articles
beginning on page 9.)Fortunate-
ly, none of them were working in
Cole Hall at the time of the
shooting. So “thank you” Becky,
Ann, and Pam for sharing.

I hope you are all enjoying
the spring. We certainly were
ready to be done with winter. In
closing, I would like to remind
our membership that the mem-
bers of the ILCRA Executive
Board are no different from the
rest of you. We are busy, working
reporters, yet we have made a
commitment to further the inter-
ests of this association. Please
don’t hesitate to contact any one
of us. I would like to think we
are friendly, approachable, and
concerned about your questions,
comments or suggestions. This is
your association. Stay involved!

— LeAnn M. Hibler

PrPresident’esident’s Messages Message
(Continued from page 1)

APRIL 26: CSR Examination,
Chicago and Southern Illinois
Area. Application filing dead-
line: February 27, 2008.

MAY 2: Continuing Education
Seminar, Holiday Inn, Mt. Vernon.

MAY 3: RPR, RMR, CRR, CBC
and CCP Skills Exam at
McCorkle Reporting, downtown
Chicago; South Suburban Col-
lege, Oak Forest (Chicago area)
and Sparks College, Shelbyville 

JUNE 20: Deadline for CSR
Application for August test.

JULY 24-27: NCRA Conven-
tion, Anaheim, CA 

AUG. 16: CSR Examination,
Chicago & Southern Illinois area 

OCT. 3: Illinois Annual Conven-
tion – Great Lakes Convention,
Schaumburg

NOV. 1: RPR, RMR, CRR, CBC
and CCP Skills Exam at
McCorkle Reporting, downtown
Chicago; South Suburban Col-
lege, Oak Forest (Chicago area)
and Sparks College, Shelbyville 

DEC. 20: CSR Examination,
Chicago & Southern Illinois area.
October 10, Deadline for CSR
Application for December  test 

MARCH 7, 2009: South Sub-
urban College - Marathon Semi-
nar. Earn all 10 CE points before
the May 31, 2009 deadline!

IMPORTANT 
ILCRA DATES

In Memoriam:

PAUL P. MARZANO, age 51,
Federal Official Court

Reporter, long-time State Offi-
cial, and ILCRA member died
on March 10, 2008. Paul is sur-
vived by his wife, children,
grandchildren, parents, sib-
lings and many nieces and
nephews.

The court reporting com-
munity has lost a great friend.
Our condolences go out to his
friends and family. 



AD INFINITUM Spring, 2008 Pg. 4

TT
eam Delta – Atten-HUT!! Sound OFF –
Blake, Miller, Bonafide, Doubet, Jenkins,
Hunniston, Thomas, Zeve. To The Hill –

MARCH!! YES, DRILL SERGEANT!!! HUT-2-3-
4, HUT-2-3-4…

Well, maybe it wasn’t as bad as all that, but at
times the three days that 80+ of us spent in Vir-
ginia and Washington, DC February 24-26
seemed like a true boot camp. It had been quite a
few years since I attended one of these intensive
legislative seminars, but all of the memories soon
came rushing back as we listened to our Drill
Sergeant for the weekend, Dave Wenhold, and his
assistants, Kerstin Roper and Nate Smith.

Our goal for this operation, should we choose
to accept it, was to stump the Hill and convince
our members of Congress to fund the mandates
of the 1996 Telecommunications Act, allowing
these dollars to flow to court reporting schools
around the country as they try to train badly

needed captioners to fulfill the requirements of
that Act.

I arrived in Alexandria a day early with
plans to meet my cousin and his wife and to
have a nice visit and enjoy some sightseeing
with them. We had a busy, but good, afternoon
visiting the Navy Memorial where I looked my
dad up in the Navy Log, driving past most of the
rest of the beautiful memorials for a brief peek,
then on to their home and a wonderful dinner at
a nearby restaurant. I felt very relaxed when
they took me back to my hotel and was ready to
face the morning’s work.

It wasn’t quite the crack of dawn when we got
up on Sunday morning, but with the hour’s time
difference it sure felt like it to Judy Lehman and
me as we hurriedly dressed and went downstairs
to face the day. I met the rest of Team Delta at
breakfast and learned that literally our team
came from coast to coast – Oregon, New York,
Delaware, New Hampshire, Mississippi, Mary-
land, Texas and, of course, Illinois. After a wel-
come and introduction by NCRA President Kathy
DiLorenzo, we got down to business.

Drill Sergeant Wenhold led us through several
hard hitting questions we would be expected to
answer on the Hill: Why should the Federal Gov-
ernment pay to train court reporters? Shouldn’t
the Broadcasters pay to train captioners since
they are the ones responsible for meeting the
mandates of the Telecommunications Act? How
many captioners are needed to meet the mandates
of the Telecommunications Act and how many
captioners are there now? Isn’t this just another
“pork” project — and on and on.

Then it was time for “Politics 101,” where we
were instructed on the nuts and bolts of how leg-
islation is made. We learned how legislators’
offices are set up, how many staffers each Senator
or Congressman has, and what these staffers’
roles are. A surprising fact to me was that, con-
trary to what I thought I had always known, it’s
much better to contact your Congressperson by
email than it is to send a personal letter. Unfortu-
nately, 9-11 and its aftermath have brought about
this change. If you mail a letter to your Represen-
tative or Senator, he or she might not receive it

(Continued on page 5)

2008 Legislative Boot Camp2008 Legislative Boot Camp

Judy Lehman (left) and Dee Doubet pose in front of the
Capitol.

By Dolores (Dee) Doubet, ILCRA Legislative Representative



for 2-3 weeks, because it has to
go through a cleansing process
to make sure it is not contami-
nated with some deadly sub-
stance. When it’s received in the
office to which it was sent, it is
more often than not in a decid-
edly unattractive state from
this cleansing process; ergo, the
preference for emails. An added
plus is that emails are answered
much more quickly than letters,
but they really need to be per-
sonalized emails and not just
forwarded, mass produced ones.

Next we spent some serious
time familiarizing ourselves
with NCRA’s Federal initiative
and the reasons for our being at
this training. Assistant Drill
Sergeants Roper and Smith
outlined our goals and made
sure we were conversant in the

issues so we would be fully
armed and could tell the mem-
bers of Congress why funding
this mandated Act is so impor-
tant to their deaf and hard of
hearing constituents across the
country.

In the afternoon we dis-
cussed grassroots campaigns
and how to use them to our
advantage, then had a panel dis-
cussion on ER around the coun-
try. Again, there was a sense of
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(Continued on page 6)

Delta Team members, Dee Doubet, Melissa Blake and Lucretia Thomas
enjoy a meal.

om page 4)
2008 Legislative Boot Camp
(Continued fr

http://www.stenograph.com
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déjà vu as I recalled the efforts
of your ILCRA board members
when ER reared its head in Illi-
nois several years ago. Some
states are losing the battle; some
are winning; some are keeping
the status quo.

After our break, we were
introduced to the scenario we
had to prepare our teams for
on Monday. It was our turn to
put into action what we had
learned so far and see if we
could come up with a workable
plan to convince the “commit-
tee members” of the urgency
and need for this important
legislative funding. Each indi-
vidual team had its own work-
ing dinner that evening as we
assigned roles to play the next
day and went over the crucial
facts we were to present. By
11:00 that night, our heads

were spinning as we finally
said good night.

Monday morning brought
the highly anticipated meetings
for each of our teams. We went
over our roles and subject mat-
ter once again at breakfast,
chose a person from our team to
be the lead speaker at our first
hearing and away we went. By
the time the first three or four
committee hearings were over,
we finally worked out most of
our nerves and found our
groove. I was so proud of my
team – each person contributed
to these scenarios, and if one
person stumbled, there was
another to jump right in with
the correct information. We
switched our lead person from
one hearing to the next, and at
the end of the day we had com-
pleted nine hearings and

answered some pretty hard hit-
ting questions from the “com-
mittee members.”. Apparently
we did well, because at the end
of the day Team Delta was
happy to join Team Echo as win-
ners of the day’s competition.

Tuesday morning saw each
of us dressed in our best busi-
ness attire as we boarded two
buses for “The Hill.” Drill
Sergeant Dave and Kerstin
briefed us along the way and
gave us our schedules. Dave,
Melanie Humphrey-Sonntag,
Judy Lehman and I had break-
fast in the House cafeteria,
then split up for our first meet-
ings. I had a pleasant personal
meeting with Rep. Ray LaHood
and one of his staffers as I
thanked him for his past sup-
port of the Training for Real-
time Writers Act and the
Telecommunications Act of
1996 and for being a cosponsor
of authorization bill H.R. 1687.
Melanie joined me about
halfway through and we left
with assurances that he would
continue to support our issues.

On to our next meeting in
Senator Durbin’s office. Judy
joined us as we met with Dave
Lazarus outside the Senator’s
office. He listened as we detailed
our issues and said he would tell
the Senator about our meeting.

Next was a meeting with
Alyssa Fisher in Senator
Obama’s office. Personally, I was
hoping to actually meet with the
Senator, but for some crazy rea-
son he felt he needed to be in
Ohio readying himself for the
next day’s presidential debate
with Senator Clinton. We met
with Staffer Alyssa instead andMelanie Humphrey-Sonntag and Dee Doubet meet with Representative Ray

LaHood from Illinois.

2008 Legislative Boot Camp
(Continued from page 5)

(Continued on page 7)



had a very productive meeting.
She was open and receptive to
our requests and promised to
pass them on to the Senator.

After our scheduled meetings
we were on our own and decided
to make unplanned visits to sev-
eral other offices, leaving pack-
ets with the staffers as we went.
When we were finally finished
about 3:00, we decided to go to
the Supreme Court building. It’s
a beautiful building and
demands respect as one enters.
Court was not in session, but we
sat in on a tour along with about
50 junior high students.

By the time the tour was
through it was time to walk to a
local restaurant and be debriefed.
Everyone was feeling pretty good
about what we had accomplished
that day, but we discovered there
was one major problem – our feet.
It seemed we had been walking
for miles along cement sidewalks
and marble floors, and even
though we had been advised to
wear comfortable shoes, our bod-
ies were still complaining. So,
instead of whining about it,
although there was plenty of that,
we came up with a creative solu-
tion for next year’s Boot Camp —

massage therapists at the debrief-
ing. With many people saying
they would take advantage of a
foot massage if it was offered, we
decided it could be a very lucra-
tive PAC fundraiser for NCRA.
There was even a suggestion that
Dave might be bribed to be the
masseur. Hey,
now THAT’S
the ticket!
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2008 Legislative Boot Camp
(Continued from page 6)

It is time once again to call for nomina-
tions for the ILCRA annual Award of
Excellence to an outstanding educator.

The guidelines are:
1. The nominee must be or have been on

the faculty of a court reporter training
program.

2. Nominations must be received by
August 1, 2008.

Name of Nominee: ______________________________________________________________________________________________

Address of Nominee: ____________________________________________________________________________________________

School of Nominee: ______________________________________________________________________________________________

Brief description of reasons why you feel this person should receive this award:

________________________________________________________________________________________________________________

________________________________________________________________________________________________________________

________________________________________________________________________________________________________________

________________________________________________________________________________________________________________

Your name: ____________________________________________________________Your telephone: ( ) __________________

Although not listed above, it is helpful in
the selection process if the nominee is an
associate member of ILCRA. All applications
submitted in previous years will be consid-
ered for the 2008 award.

Nominations may be submitted by stu-
dents, fellow faculty, administrators, or
ILCRA members to:

Nancy C. Davis, Executive Director
41 SW Crescent Drive, Mt. Vernon, IL 62864

Street City State Zip

Do YDo You Know ou Know 
an Outstanding Educator?an Outstanding Educator?

Nomination for ILCRA Award of Excellence
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COURT REPORTING SERVICES — STATE OF ILLINOIS
AND ILLINOIS COURT REPORTERS ASSOCIATION

2008 COUR2008 COURT REPORT REPORTING SERTING SERVICES SEMINARVICES SEMINAR
MAY 2, 2008 

Holiday Inn, Mt. Vernon

PROGRAM AGENDA
8:00 - 9:00 a.m. REGISTRATION & CONTINENTAL

BREAKFAST

CONCURRENT A.M. SESSIONS:

9:00–10:30 a.m. REALTIME This session is designed
for the busy reporter wishing to get more done
in less time. Topic includes speed building,
a/k/a cleaner, faster realtime, a/k/a increased
productivity. Presenter: Melanie Sonntag, a
Registered Diplomate Reporter, Certified
Realtime Reporter, and a Fellow of the Acade-
my of Professional Reporters.

9:00–10:30 a.m. & 10:30 a.m.–noon FINANCIAL
PLANNING This session is designed to assist
reporters in compiling strategies for their
financial futures. Presenter: Rik Stone, a
financial advisor from the firm of Robert
Gordon and Associates.

9:00–10:30 a.m. & 10:30 a.m.–noon PERSONAL
EFFECTS OF TRAUMA/STRESS MANAGE-
MENT TECHNIQUES This session is geared to
the everyday stresses of reporting and will
cover management techniques to combat the
effects. Presenter: Sandra K. Vicari, Ph.D.,
LCPC. Dr. Vicari is a Clinical Assistant Pro-
fessor with the Southern Illinois University
School of Medicine, Department of Psychia-
try.

10:30–noon FILE BACKUP, STORAGE & ORGA-
NIZING This session will review the best ways
to manage, backup and store steno notes for
both paper notes and paperless writing. Pre-
senter: Pam Sczczecinski, Stenograph.

9:00 a.m.–4:00 p.m. COACHING, MENTORING &
TEAM-BUILDING SKILLS (all day session,
Oak Brook only) This session will help super-
visors gain the tools and skills needed to
become a stronger, more confident leader
who gets exceptional results through others.
Presenter: Lisa Walker, Rockhurst University
Continuing Education Center.

12:00 p.m.–1:00 p.m. GROUP LUNCH

CONCURRENT P.M. SESSIONS:

1:00–2:30 p.m. COURT REPORTING SERVICES
INFORMATION SESSION This session will
have information updates on court reporting
services issues. Registrants for this session
should submit any questions in writing prior to
the seminar on the form enclosed in the regis-
tration packet. Presenters: Hon. S. Gene
Schwarm, Chief Judge, Fourth Judicial Circuit;
Tammy Bumgarner, CRS Program Coordinator.

1:00–2:30 p.m. & 2:30–4:00 p.m. FELONY DUI This
session will cover the process involved from
arrest through sentencing in cases involving
felony DUI convictions. Presenters: Office of
the DuPage County State’s Attorney, Office of
the Sangamon County State’s Attorney, Office
of the Jefferson County State’s Attorney.

1:00–2:30 p.m. & 2:30–4:00 p.m. COURTROOM
SECURITY This session will cover issues of
safety for reporters prior, during and after
being in the courthouse. Presenter: Deputy
Cory Orphan, Illinois Sheriff’s Association

2:30–4:00 p.m. COMPUTER SOFTWARE TRAINING
This session will allow reporters with the same
software to get together and share tips to best
utilize the software. Each group will have an
appointed instructor or moderator. Bring your
computers for the full benefit of this session.
NOTE: Due to the different software that is
utilized, only the groups with sufficient regis-
tration will be scheduled. If your software
group is not available, you will be registered
for either Felony DUI or Courtroom Security.
Presenters: Pam Sczczecinski, Stenograph;
Julie Samford Davis, Eclipse.

4:00 p.m. SEMINAR CONCLUDES

FOR REGISTRATION INFORMATION see the
ILCRA website www.ilcra.org or call ILCRA
headquarters at 1-800-656-2467.

http://www.ilcra.org


AD INFINITUM Spring, 2008 Pg. 9

(Continued on page 10)

ILCRA extends heartfelt condolences to all who were affected by the Northern Illinois University
shooting on February 14, 2008. ILCRA members, Becky Dawson, Ann Pellican and Pam Wixom, are

CART providers on the NIU campus. In the following three articles they share their experiences about
that fateful day and how it has affected them. 

NIU Tragedy:

CARCART PrT Providers Sharoviders Share Their Storiese Their Stories

NIU TRAGEDY ON
2/14/08 
By Becky L. Dawson, CSR,
CART Provider 

FFe b r u a r y
14th, 2008,
was sunnier

and a little warmer
than it had been
for weeks. I decid-
ed to walk across
campus to my 2:00

class in Dusable at NIU, which
took me right past Cole Audito-
rium, the site of NIU’s devastat-
ing tragedy. Although it was
windy, the sun felt good on my
face. I had no idea what NIU
would be facing at 3:06 that
afternoon.

When the class that I was
CARTing ended at 2:50, I
packed up my equipment and
made my way down from the
fourth floor of Dusable. For
some reason unbeknownst to
me at the time, I felt absolutely
compelled to walk a different
way than the way that had
taken me through the center of
campus. This feeling was unbe-
lievably strong. The right angle
of the triangle made my walk a
little longer as I headed straight
for Lucinda Avenue, but the
pull was so strong that I just
went with it. I didn’t realize
until 11:30 that night that my
alternate route had precluded
me from walking past Cole
Auditorium. Do you believe in
guardian angels? I do.

As I was walking down
Lucinda Avenue toward my

next class, I noticed an NIU
police officer. I had an extra
long time to observe his face
because he was stuck in traffic.
He had such a look of determi-
nation on his face.

Next I noticed a fire truck
and an ambulance screaming
down Russell Road. My first
thought was that one of the
pedestrian/NIU students must
have gotten hit. It would not be
unusual to send a fire truck, an
ambulance, and a police officer
to a tragedy like that.

As I was setting my equip-
ment up for the next class, sud-
denly everyone’s cell phones
began to ring. It was the
strangest thing for ten random
students to all get phone calls
simultaneously. I remember my
hearing-impaired student say-
ing, “Mom, I’m fine. Stay put.
I’ll let you know where I land.”
Somehow his mom knew about
the tragedy even before the NIU
students did. Next, a secretary
from the Latino Center came in
and said, “There is a shooter at
Cole Auditorium. Some people
have been shot. We don’t know
how many. The shooter is still
at large. NIU is officially in
lockdown. You may leave, but if
you leave, you will not be able
to get back in.”

I remember looking at the
glass doors of the Latino Center
and thinking, what would pre-
clude a crazy man with a gun
from shooting through our
“locked doors” if he chooses to?
I asked my student what he

wanted to do, stay or leave. He
said that he’d really like to get
off campus to meet his mom who
just happened to be in town.
There was the adrenaline factor
with the fight or flight response.
My car was a block away and
my student chose to wait at the
Latino Center while I retrieved
the car. Tons of people were
already flooding the streets try-
ing to get off campus. It took us
about ten minutes to go two
blocks. I nervously watched my
rear-view mirror the entire time.
It was my intent to get as far
away from campus as possible.
Within a half hour, my student’s
very appreciative mom met us at
a grocery store on Highway 23.

I met my husband and
another couple for dinner that
night. After all, it was Valen-
tine’s Day, but I felt like I was
just going through the motions. I
was having trouble wrapping
my mind around such a horrific
event. I still can’t believe it. Our
friends invited us to their home
to watch a movie, so we drove to
their house. Before we started
any movie, I wanted to check
online for an NIU update. There
was a picture on the website of a
local newspaper of a girl with a
gunshot wound through her
forehead. The girl looked just
like one of my students! That
was enough to send me over the
edge. I lost it! I immediately
started to cry and told our
friends I couldn’t stay. I had to
go home and call this particular
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student and make sure she was
all right. During the ride home I
remember chastising myself
about not being able to remem-
ber what she had been wearing
that morning when I CARTed a
class for her. “Did she have her
gray NIU sweatshirt on or not?”
I grilled myself. I couldn’t
remember, and the more I could-
n’t remember, the more I cried.

To my utter relief, my stu-
dent was fine. I called another
student whose phone number I
had and she was also fine. Even
though it wasn’t my particular
student on the gurney, it was
somebody’s sister, daughter,
loved one.

There were a total of six
people killed that day, including
the shooter, and multiple, multi-
ple wounded students physical-
ly as well as psychologically.

My student shared with me
recently that she actually was
one mouse click away from
signing up for that particular
class in Cole Hall. She decided
against it since she didn’t want
to carry 17 hours. There are
only four CART providers at
NIU, and since we always sit in
the front row, the “what ifs”
have been a little bit of a head
trip for the four of us.

NIU has done an outstand-
ing job post-tragedy. There
was a week of healing where
they had a staff meeting and
multiple counseling sessions to
help the staff work through
their various issues. Even peo-
ple that were not on campus at
the time have been deeply
affected by this tragedy. The
counseling session for the
CART providers and sign lan-
guage interpreters was espe-

cially helpful, and we have all
become even closer to each
other than we were before.
Each of us has a different way
of dealing with this indescrib-
able loss.  Many of us have
depended upon our individual
faiths to see us through the
worst times. We have coun-
seled together, cried together,
put flowers at the memorial
crosses, had numerous lunch-
es, and processed information
about the shooter together.

It was a great privilege to
attend the memorial service
that NIU hosted and be able to
sit with co-workers and hear-
ing-impaired students. The
CART services that Pam Wixom
provided as well as the sign
language by Luke and Michelle
made the memorial service
especially meaningful. (Pam,
you were calm under pressure,
and you are my hero forever!)

When classes resumed on
Monday, there were counselors
available in every single class-
room in case students wanted to
talk. Also, there were volunteer
policemen in every building. I
thanked every volunteer I saw,
especially the policemen. There
were alumni stations where
they were giving out free food
to students and staff. I person-
ally met volunteer counselors
from four different states who
had come to assist NIU in its
healing process.

There was a student in my
Tuesday night class that just
sat there and cried. The coun-
selor finally was able to get
this student to share a little.
All the student could say was,
“I was there. I was in the class-
room when it happened.”

Those who were actually in
Cole Auditorium as well as the
family and friends of those
injured or killed are the most
impacted, and their devastation
is exponentially more than
ours, but anyone affiliated with
NIU in any way will forever be
bonded together. Life can be
forever changed in an instant,
and we should live each day
like there is no tomorrow.

“Forward, Together, For-
ward.”

VALENTINE’S DAY, 
A DAY OF LOVE
By Ann Pellican, CSR,
CART Provider

IIt was a little
over three
years ago, and

I decided it was
high time to make
a career change.
After freelancing
for 18 years, I was

burnt out with the legal side of
our profession. Convinced that
you can teach old dogs new
tricks, I enrolled in a real-time
class at Midstate College.
Before long, a colleague
informed me that Northern Illi-
nois University was in need of
another CART provider. Ready
or not, I found myself taking all
of the necessary steps to
become a CART provider, and
thus began my employment at
Northern Illinois University.

Although I found my new
position to be not only mentally,
but also physically demanding,
I quickly realized how this skill
that I learned 20-plus years ago
could be so rewarding. I have

(Continued on page 11)

NIU Tragedy
(Continued from page 9)



AD INFINITUM Spring, 2008 Pg. 11

worked with several students and have man-
aged to make close bonds with them. What
started off to be a huge step out of an 18-year
comfort zone now was beginning to feel like a
good fit.

February 14, 2008, started off like every
other day. The same hectic routine of getting
myself up and ready for work, then stirring
my three boys out of bed, making sure they
eat breakfast, get cleaned up, and out the
door on time with everything they need for
school in hand. Then I start my one-hour trek
from my home to NIU. Tuesdays and Thurs-
days are light days for me this semester. I
CART a three-hour class with a student from
India whom I have grown to love like a
daughter. I brought her a Valentine’s Day
chocolate treat. I asked her if she knew what
Valentine’s Day was all about. She replied,
“Yeah, it’s the day you give flowers and
candy.” I assured her she was right, but the
tradition of Valentine’s Day stemmed from the
patron saint of love, St. Valentine, and this is
the day that we share our love with those we
care about. With that, she gave me a hug and
told me she loved me. How that moment
would come back to haunt me!

Our lab ended at 12:15, and I started my
one-hour trek back home. I picked up my kids
at school, and then ran some errands. It was
then that a fellow reporter called me to see if I
was aware of what was going on at NIU. She
said she had her TV on, and there was live cov-
erage of a shooting on campus. I was shocked
and in disbelief. My first thought was to call a
fellow CART provider whom I knew was still
on campus as well as my student from India
whom I knew was working in one of the com-
puter labs. I was also very worried that one of
our sign language interpreters might have been
in harm’s way. I was very concerned about
everyone’s safety, as well as the children of
close friends of mine who attend the university.
When I returned home, I immediately checked
my email. Our supervisor left a message that
the university would be closed on Friday, and
all of our staff was safe! What a relief it was to
read those words!

(Continued on page 12)
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For the next few days it seemed as if every
waking moment was spent on the phone. I was
overwhelmed at the outpouring of concern for my
safety and well-being — family, friends, and co-
workers just needing to hear my voice to know
that I was okay.

As details began to be revealed, the reality of
this horrible tragedy began to set in. My heart
ached for the families and friends of the students
who had been killed and injured. I empathized
with the all of the students who were in Cole Hall
and could only imagine the terror they had gone
through.

At first I disassociated myself with what had
happened. I wasn’t in that classroom. This didn’t
happen to me. But when I started imagining
myself going back to the classroom, especially the
big lecture halls, I realized that this tragic event
affected everyone who is in any way a part of the
NIU community. It wasn’t until late Saturday
afternoon that we learned the university would

be closed the following week. This would be
called “The Week of Healing.”

On Tuesday of the next week, our office,
which consists of sign language interpreters and
CART providers, attended a counseling session
for faculty and staff. This was our first day back
on campus. After our counseling session, we
walked across campus in the bitter cold to Cole
Hall. Cole Hall was still barricaded off with yel-
low warning tape. We laid flowers under the
warning tape, stood quietly, and breathed deeply.
A building that only a few days before was
bustling with a constant flow of students going
in and out now was hallowed ground. Within
minutes, we had a newspaper reporter asking
questions, and almost at the same time there
were TV cameras in our faces. They wanted to
know our stories, why we were there, and our
connection to this horrible occurrence. It seemed
surreal that we should even have to be sharing

NIU Tragedy
(Continued from page 11
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our stories, just as it does right
now as I write this article.

On Wednesday, we attended
a counseling session only for
our captioning and interpreting
staff, a much needed session to
share our shaken sense of secu-
rity, our apprehension of
returning to the classroom, the
nightmares that seemed to be
popping up, and the “what-
if’s.” The week ended with a
beautiful memorial service in
which one of our very own
CART providers was brave
enough to caption for our hear-
ing-impaired students.

The return to classes on
the following Monday was a
very difficult day for all. I saw
tears,  blank faces,  and yet
there was an uncanny sense of
an awareness of every person
you passed, a sense that we
are all in this together, feel-
ings that were never present
before. It was eerily quiet in
every class, something very
unusual for a campus of
25,000 students. Five hundred
fifty counselors from all over
the country were in every
class on Monday and Tuesday
to offer their services and to
also allow anyone who was
inclined to share their
thoughts, their fears, and their
experiences.

As the week went on, things
gradually seemed to return to
some sense of normalcy. People
were more at ease. There was
conversation and even laughter,
two things that were very much
absent on the first few days of
classes.

Now that a month has
passed, the NIU community is
healing and moving forward. I

wonder if my student from
India will think of February 14
as a day of love or if it will
forever be a memory for her of
a day that a very troubled
young man took his own life
and the lives of five others. No
one will  ever know why. I
don’t think that question will
ever be answered. If one lesson
can be learned from an event
like this it would be that one
should never take anything for
granted. We should be thank-
ful for every day we are given,
and we should be thankful for
the people who are a part of
our lives — every day is a gift,
and every person is a gift. NIU
will never be the same, but we
will continue to move “For-
ward, together forward.”

A TRAGEDY ON CAMPUS
By Pam Wixom, CSR, CART
provider

IIt was 2:45 on
F e b r u a r y
14th, and I

was heading to my
last three-hour
class of the day.
Class started as
usual. At approxi-

mately 3:10, a male professor
came into the room and told the
class that there was a gunman
on campus and we needed to
get down in the back of the
room, shut off the lights, lock
the door and be quiet. There
was approximately 20 students
in the classroom. We all headed
to the back of the room and sat
down on the floor next to each
other. I sat there quietly and
started praying hoping we
would all be all right and I
would be able to get home to

my family. In all of the quiet-
ness, occasionally I would hear
what sounded like door slams
and just hoped it wasn’t the
gunman coming in.

Approximately 30 minutes
later, I heard keys in the door
and the same man walked in
the room. He told us that there
was a shooting in Cole Hall. He
said we were allowed to try to
use our cell phones and let our
family know we’re okay, but we
were not allowed to leave the
building because the campus
was not secure.

Several of the students got
on their cell phones and tried to
find out exactly what was going
on. I had not taken my cell
phone into the classroom with
me, so I was unable to contact
my family. Reports kept coming
in from the students saying five
people were shot. And then it
was seven. And then nine. And
then 12. Quickly helicopters
were hovering over campus. We
could hear lots of sirens.

Approximately an hour
later, there was an announce-
ment over the intercom stating
that campus was secure and we
were able to leave. It was also
stated that classes for the night
were cancelled, buses were not
going to be running, and classes
would be cancelled on Friday.
Knowing how scared I felt and
knowing that my student was
going to have to walk across
campus, I offered him a ride to
his apartment.

As I got to my car, I got my
cell phone. I already had 10
messages. My phone started
ringing again as I got into the
car. It was my boss calling to

(Continued on page 14)

NIU Tragedy
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see if I was okay and asking me
if I was leaving campus. I told
him yes and asked how every-
one else was. He told me that
everyone from our office was
safe. That was a relief.

It is a 45-minute drive for
me to get home. My phone rang
my whole way home with fami-
ly and friends calling to check
to make sure I was okay. I did-
n’t even get a chance to listen to
my messages until later on in
the evening.

When I arrived at home, I
checked the website of the cap-
tioning company I work for,
and, of course, there was emer-
gency coverage for the shooting
at NIU. I went ahead and
picked up 45 minutes of cover-
age, knowing that I would
know lots about the story.

Later that night when I was
prepping to caption my show at
10:00, I started feeling very
nauseous. I contacted the cap-
tioning company, who knew I
was at NIU during the incident,
and told them I wasn’t sure I
was going to be able to do my
news and asked for backup.
They told me I should just take
the night off considering what
happened. I told them I would
go ahead and do my show but

please have someone there
ready in case I get sick.

The first story on the Ohio
station I was covering was the
shooting at NIU. It really start-
ed sinking in what had hap-
pened. They did not have a
name of the shooter yet, but
they did have the number of
victims. I just couldn’t believe
this had happened.

After my half hour of news
was over, I broke down and
started crying. I kept checking
the NIU website to find out the
latest information. For the next
few days, I could not stay away
from the TV coverage. I even
picked up the emergency cover-
age press conference when they
were going to announce the
shooter’s name.

I called my boss on Satur-
day afternoon to check to see if
he had any information about
when we were to return to
work. That was one thing they
kept not reporting about. The
reports were just that classes
were cancelled until further
notice. I thought perhaps my
boss would have more informa-
tion. And as the time kept get-
ting closer and closer to think-
ing I might have to go back to
work on Monday, the more anx-

ious I was feeling. He had no
information. Later the NIU
website reported that school
was cancelled for the next
week. I was so glad when I
heard that. I knew I was not
ready to go back to work yet.

The week after the shooting,
the staff and faculty were asked
to come to counseling sessions to
prepare us to come back to
work. The first meeting I attend-
ed, along with some of my co-
workers, was on Tuesday. It was
a step towards starting the heal-
ing process. There was definitely
lots of emotion from everyone in
the almost-filled auditorium.
There was a counselor from Vir-
ginia Tech who spoke, and it
was very comforting to have
someone share his experiences
from a similar situation.

After the meeting, my co-
workers and I decided that it
would be a good idea to go over
to Cole Hall and pay our
respects to the victims. We knew
how hard it would be to have to
walk past Cole Hall for the first
time, so we wanted to do it
before we actually returned to
work. We all had some flowers
to put by the memorial site. We
had a moment of silence. We

NIU Tragedy
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also went over to the Martin Luther Commons
area and signed the memorial boards they had
placed there.

On Wednesday, there was a special meeting
that we attended for just the CART providers and
sign language interpreters with a counselor. This
session was especially helpful. It validated our
anxiousness of returning to work and being in the
front of the classroom again, something none of
us were looking forward to. It was very comfort-
ing to know that every one in that room was hav-
ing the same apprehension.

During this whole week of trying to heal to
come back to work, my co-workers and I stayed
in very close contact with each other, making sure
we were calling each other to see how we were
feeling. We did a lot of hugging, too. The coun-
selor said it was very helpful in the healing
process if we supported one another.

As we returned to work on Monday, we all con-
tinued to check on each other and hug one another.
The mood around campus was very somber. There

was a counselor present in every room, and at the
beginning of class the counselor was informing
everybody of the services available to anyone who
thought they needed help. The majority of students
had blank stares on their faces during class, as if
they were not even there. Teachers could not get
any class participation. The one thing that did
stand out to me, though, was the kindness that
everyone was showing to one another, even from
complete strangers. For the first time when shar-
ing an elevator with a stranger, they would ask
how I was today. The outpouring of support from
everyone in the community has been very helpful.

As time goes on, things seem to be getting
somewhat back to normal. It’s not quite as dis-
turbing when a student, late for class, enters the
front of the classroom after class has already
started. I must say, I am still very aware of who is
coming in that door. But I know with the support
of my co-workers, friends, family and the whole
community, we will get through this tragedy
“Forward, Together, Forward.”
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application form and $25 for dues.

4. An instructor’s certification form signed by a court reporting instructor. (See below.)

Instructor’s Certificate:

I hereby certify that the above-named student:

_____ has completed at least one year of attendance at this court reporting school,

_____ has successfully transcribed five minutes of testimony at 160 words per minute,

_____ is presently attending an Illinois court reporting school or is an Illinois resident attending
an out-of-state court reporting school.

Instructor’s Name:____________________________________________ Title: __________________________

______________________________________________________Date:___________________________________
(Instructor’s Signature)

Name of court reporting school:________________________________________________________________

Submit application and attachments by August 1, 2008 to:

Bernice Radavich, 27 Longwood Way, Lemont, IL 60439

ILCRA Student Scholarship Essay CompetitionILCRA Student Scholarship Essay Competition

2008 ILCRA STUDENT SCHOLARSHIP APPLICATION
All entries must be postmarked no later than August 1, 2008.

$$TUDENTS, YOU COULD WIN $500
plus a complimentary registration to
ILCRA’s Annual Convention October 3-5,

2008 at the Hyatt Regency Woodfield, in
Schaumburg, IL. The prize includes hotel accom-
modations for one night and roundtrip mileage
reimbursement.

To enter the contest, compose a one-page,
typewritten, double-spaced essay entitled
“Making Connections." You must meet the quali-
fications specified on the application below and
submit your letter, completed scholarship appli-
cation form and instructor’s certificate (see below)
postmarked no later than August 1,  2008.

Come on students, give it a try! You have noth-
ing to lose and much to gain. Even if you don’t win
the scholarship, please attend the convention. You
are always welcome, your convention registration
fee is greatly reduced.

REPORTERS:
Please help an outstanding student by con-

tributing generously to the ILCRA student schol-
arship fund. Demonstrate your encouragement to
the reporters of tomorrow. Donations in any
amount are greatly appreciated. Make your check
payable to ILCRA and mail it to: 

Nancy C. Davis, Executive Director
41 SW Crescent Drive, Mt. Vernon, IL 62864.
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MMidstate College in Peoria, Illinois, is a pri-
vate college that was established in 1888
and has offered programs in court report-

ing since 1974. Midstate College currently offers an
Associate of Applied Science Degree in Judicial
Reporting and a Bachelor of Science Degree in
Realtime Reporting, which is one of approximately
six baccalaureate degrees of its kind in the country.
Midstate College’s B.S. degree includes concentra-
tions in Broadcast Captioning, CART Reporting,
and Judicial Reporting.

The Realtime Reporting Program has received
federally-directed funds in the past to create and
support the program to help meet the mandates
of the Telecommunications Act of 1996 in regard
to broadcast captioning. The College started its
first Realtime Reporting cohort in August of 2005
and celebrated its first broadcast captioning con-
centration graduate in November of 2007.

Midstate College is accredited by the Higher
Learning Commission and is a member of the
North Central Association of Colleges and Schools.

The B.S. Degree in Realtime Reporting offers a
wonderful opportunity for new students to learn
realtime reporting skills and earn a baccalaureate
degree in approximately the same amount of time
it takes the average student to reach the required
levels of speed and accuracy. Working reporters
and students who have already completed an asso-
ciate degree in judicial reporting or broadcast cap-
tioning now have an opportunity to complete a
four-year degree in this highly specialized and
technical field of study. The degree also provides
an avenue for working judicial reporters to transi-
tion into CART or broadcast captioning.

One of the great advantages for working
reporters and graduates who have attained pro-
fessional certification(s) is the experiential credit
Midstate College recognizes for academic credit
based on the recommendations of ACE (The
American Council on Education) for the Illinois
CSR and NCRA certifications. Upon application
to the College, the prospective student’s previous

Midstate College OfMidstate College Offers Realtime Reporfers Realtime Reporting Degrting Degreeee

(Continued on page 21)

If you are an enthusiastic, meticulous reporter wishing to join 
our supportive and friendly team, call Dayna at 312-781-9586 to set up an interview. 

Serious inquiries only. RPR or higher. Must be on CaseCatalyst. 
All responses strictly confidential.

• Employee status – payroll taxes deducted

• NO RENT

• Competitive rates 

• Networked server/DSL at your desk

• 401(k)

• Health Insurance 

• Support staff handles production

• Four days a week

• High percentage of writeups

• City and suburban work

• No seniority system

• Supplies/equipment provided

EMPLOYEES WITH BENEFITS

URLAUB BOWEN & ASSOCIATES 
IS SEEKING FULL-TIME IN-HOUSE REPORTERS

WE OFFER:
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Midstate College
Improve YImprove Your our 

RRealtime Skills in 2008!ealtime Skills in 2008!
ILLINOIS COURILLINOIS COURT REPORT REPORTERTER

TRAINING PROGRAMS TRAINING PROGRAMS 
MACCORMAC COLLEGE*

www.maccormac.edu
29 E. Madison St., Chicago, IL 60602-4405

Tel: (312) 922-1884; Fax: (312) 922-3196

SOUTH SUBURBAN COLLEGE* 
www.southsuburbancollege.edu

16333 So. Kilbourn Ave., Oak Forest, IL 60452
(708) 596-2000

MIDSTATE COLLEGE*
www.midstate.edu

411 W. Northmoor Rd., Peoria, IL 61614
(309) 692-4092

SPARKS COLLEGE* 
http://sparkscollege.org

131 South Morgan St., Shelbyville, IL 62565
(217) 774-5112

JOHN A. LOGAN COLLEGE 
www.johnalogancollege.com

700 College Rd., Carterville, IL 62918
Brenda Erickson, Ed.D.CPS

Office Technology, Business Education

COURT REPORTING INSTITUTE 
OF AMERICA 

www.ciamerica.org
One Pierce Place, Suite 475 W, Itasca, IL 60143

(630) 250-5999
Illinois Occupation Skill Standards for Court

Reporter/Captioner

*NCRA Certified

STENO KEYBOARD OR MACHINE 
$10 EACH

2 NEW CHARMS!

THESE
CHARMS 

ONLY 
$3 EACH!

Just click this link or go to the ILCRA store at
www.ILCRA.org

BRACELETS $5!

om page 20)

NOW AVAILABLE FROM ILCRA’S
ONLINE STORE!

CONFERENCE ROOM AVAILABLE

L & L REPORTING SERVICE, INC.
COURT REPORTERS

9 North County Street
Waukegan, IL 60085

(847) 623-7580
FAX (847) 623-7597Lori A. Eder, CSR, RPR, RMR

college credits and certifications will be evalu-
ated for transfer credit.

If you are interested in receiving information
on the Realtime Reporting Bachelor of Science or
Judicial Reporting Associate of Applied Science
Degrees at Midstate College, please call (800) 251-
4299 and speak with an admissions representa-
tive; ask about the availability of online courses.
For specific program questions, contact Teresa
Ozuna, CSR, CRI, Realtime Reporting Program
Coordinator, at (800) 251-4299, ext. 2281.

(Continued fr

http://www.ilcra.org
http://www.maccormac.edu
http://www.southsuburbancollege.edu
http://www.midstate.edu
http://sparkscollege.org
http://www.johnalogancollege.com
http://www.ciamerica.org
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           New Benefit Offering for the Illinois Court Reporters Association 
The need for cancer insurance is very real. According to statistics, in the U.S., men have a one-in-two 
lifetime risk of developing cancer, and for women the risk is one in three.* Everybody knows somebody 
who has had cancer, and this disease affects all age groups. 
 
As serious as the threat of cancer may be, new and improved treatments are being introduced, and studies 
are showing that regular screening tests can detect some cancers in the early stages. But with high 
technology come high costs. The American Cancer Society reports that cancer costs Americans more than 
$107 billion.* And much of that amount is considered indirect or hidden costs not covered by major 
medical plans. 
  
Colonial's cancer insurance can help.  It helps you deal with the financial problems that may be 
associated with cancer detection and treatment. Benefits can be used to help pay for: 

 Specified cancer-screening tests. 
 Radiation and chemotherapy.  
 Transportation and lodging.  

 
Plus, your Colonial cancer policy is designed for you: 

 Benefits are paid directly to you, unless you specify otherwise. 
 Benefits are paid regardless of any other insurance you may have with other insurance companies. 
 The coverage is portable; you can take it with you if you change jobs or retire. 

 
* Cancer Facts & Figures, American Cancer Society, 2000. 

 
HELP PROTECT YOURSELF AND YOUR FAMILY FROM THE HIGH COST OF CANCER 
TREATMENT WITH COLONIAL’S CANCER INSURANCE FOR ILCRA MEMBERS. 
 
 

 

Policies have exclusions and limitations that may affect benefits payable. 
Policies or provisions may vary or be unavailable in some states. 

Call Ira Hymen at (847) 996-0241  

Colonial Supplemental Insurance products are underwritten by: 
Colonial Life & Accident Insurance Company 
1200 Colonial Life Boulevard, Columbia, South Carolina 29210 
www.coloniallife.com 
© 2002 Colonial Life & Accident Insurance Company. “Colonial Supplemental Insurance” and 
the logo, separately and in combination, and “for what happens next” are service marks of  
Colonial Life & Accident Insurance Company. All rights reserved. 
SW122 
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http://www.coloniallife.com
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AMY’S BRIEFSAMY’S BRIEFS

It’s been six years since my first Briefs article for
Ad Infinitum. All good things must come to an
end. I’ve shared several briefs with you through

the years, and I am sure I will continue to invent
more with each passing day. However, I have decid-
ed it’s time for new faces and new ideas for Ad
Infinitum, so this will be my last column.

With the help of Nancy and Glennda Davis, I
have compiled all of the data from the briefs
columns for the last six years. There are 34 cate-
gories and over 800 briefs. That compilation has
been burned to CDs and those CDs are for sale
for $5 each. All proceeds go to the Illinois Court
Reporters Association. They will be available at
the spring ILCRA seminars and at the Great
Lakes Convention at the ILCRA sales table.

Now, let’s have a little fun for our last column
together. Unless another reporter happens to look
over your shoulder while you are writing, no one
knows what strokes you use to define any certain
word or speaker designation.

So, if you are having a particularly boring
day, why not spice things up a bit? When picking
a stroke for speaker designation for that attorney
that came in with his hair sticking straight up
from the windstorm outside, use HAIR/HAIR to
designate him speaking. If you are a CART
provider and the instructor is an annoying sort,
just enter PAIN/PAIN in your job dictionary as
his or her speaker designation. Or, if one of the
defendants has a little trouble keeping the pants
of his jail uniform up over his back side, well,
instead of the usual D+answer bank, why not use
KRAK/KRAK when he chimes in? Yes, we all
need to take our jobs seriously and maintain a
professional appearance, but sometimes you
need a diversion from the things our ears are
subjected to.

One of our former State’s Attorneys was a nice
guy but just a little full of himself. Other folks in
the courthouse often referred to him as “The
Prince.” So I carried that moniker through. Every
time he spoke in court, I wrote PRINS/PRINS. No
one was the wiser and I got a little chuckle out of
it every time he spoke! Well, okay, no one was the
wiser until I just published it in an article that is
now available on the internet.

I hope you will continue to have some fun brief-
ing. I’m going to leave you with a few brief forms
that will hopefully bring a smile to your face.

SURE! I’d be happy to place my name prominently before my fellow ILCRA members and drum up a
little business while showing support for my state association. Please display my business card in the
next four issues of Ad Infinitum. Enclosed is my card and a check made payable to ILCRA for $100.

Name: ________________________________________________________________ Ph:( ) __________________

Address: ____________________________________________________________________________________________

Mail to: Nancy C. Davis, Executive Director, ILCRA, 41 SW Crescent Drive, Mt. Vernon, IL 62864.

WE WWE WANT YOUR BUSINESS CARD!ANT YOUR BUSINESS CARD!

Osama bin Laden ........SLO*B 
Saddam Hussein ........SHA*IM 
Bill Clinton ..................BLO*EN 
Michael Vick................DO*G 
Donald Trump ..............D*UFPL  (-FPL is mp) 
Britney Spears ............TRA*RBD 
Michael Jackson..........FRAO*EK 
Prince Charles ............AO*ERS 
irrelevant ....................B*S 
you may proceed ........BA*BL

NEW PROFESSIONAL MEMBERS:
Sandra A. Brennan, Chicago

Leslee Copple, Benton
Brenda D. Gregory, Naperville
Janet L. Hamm, Jacksonville

Tierney Mackin, Shorewood, WI
Paula A. Morsch, Morton

Michele L. Thomas, Benton
Gina M. Zangara, Crystal Lake

ILCRA WELCOMESILCRA WELCOMES 88 NEW MEMBERSNEW MEMBERS

by Amy B. Haught, CSR, RMR, CRR, Immediate Past President



AD INFINITUM Spring, 2008 Pg. 24

Gary L. Sonntag Memorial Speed Contest Registration Form
Great Lakes Regional Convention • Hyatt Regency Woodfield, Schaumburg, IL

Friday, October 3, 2008 • 9:00 a.m.
Speed contest registration fee is $60.

Name: __________________________________________________________Phone: ( ) _______________

Mailing Address:______________________________________________________________________________

City:__________________________________________________State:___________________Zip: __________

Bus. Ph: ( )_______________________________Hm. Ph: ( ) __________________________________

Deadline for Registration is Aubust 1, 2008

Calling All Fast-Fingered Folks!

GarGary L. Sonntag Memorial Speed y L. Sonntag Memorial Speed ContestContest

ILCRA

2008
OCTOBER 3–5

ANNUAL CONVENTION

HYATT REGENCY WOODFIELD
SCHAUMBURG, IL

TRANSCRIPTION 
TEST SPEED TIME
Literary 220 wpm 90 minutes
Legal Opinion 230 wpm 90 minutes
Testimony 270 wpm 90 minutes

1. Eligibility: Any writer of shorthand (pen or
machine) who is a member in good standing of
NCRA and ILCRA is eligible.

2. Tests: Five-minute tests will be dictated as follows:

3. Number of transcriptions permitted: One of each
take.

4. Professionalism barred: Contestants must give to the
ILCRA Board satisfactory assurance that they have
not received, directly or indirectly, any remuneration
or promise of remuneration of whatever character
for entering or winning any part of this contest.

5. Entry fee: $60.

6. Pre-registration: All contestants must submit their
contest registration forms at least 30 days prior to
the contest to ensure availability of adequate tran-
scription facilities and familiarity with contest
rules.

7. Awards: The contestant who qualifies on the three
above tests with the highest average for the
three shall be awarded the first-place
plaque. Second-and third-place
plaques will awarded to those con-
testants who place second and
third overall. Appropriate certifi-
cates will be awarded to any con-
testant who qualifies in any of the
three speeds.

The contestant who qualifies in the three above tests
with the highest average of those contestants who
reside in Illinois will be awarded the Sally J. Cochran
Traveling Cup. In addition, the first-, second-, and
third-place overall winners will receive a medallion
memorializing Gary L. Sonntag, as well as a certifi-
cate. No transcript will be rated that has more than
five percent of errors.

8. Transcribing: A printer will be provided for con-
testants to use in transcribing. Otherwise, equip-
ment for transcription is the responsibility of the
individual contestant. Contestants are responsible
for producing their own transcripts without assis-
tance from another person. Those who type must
type their own transcripts; those who use computer-
aided transcription must perform their own trans-
lating, editing, printing and proofreading functions.

In every sense, the contest transcripts must be the
work product of the individual contestant. Any
activities that call into question the integrity of a
transcript may be reason for permanent disbarment
from the Speed Contest.

9. Decisions: All decisions of the Speed Contest
Committee and the ILCRA Board made under

these rules, or such supplementary rules
as may be found necessary at the time

of the Contest, shall be final. 

10. Continuing Education Credits:
.4 CEUs are allowed by NCRA for
each section of the speed contest
in which the contestant qualifies.
Qualification is based on tran-
scription at 95% accuracy.

Please submit this form, along with your registration fee of $60 to:
GLRC c/o MAPCR, P.O. Box 366, Pinckney, MI 48169

Or you may include registration fee with your convention registration. 



TESTING CRITERIA:Five minutes of literary
material dictated at 180 words per minute.

ELIGIBILITY: Any writer of shorthand who is a
member of ILCRA in good standing and who
has attained at least RPR, CBC, or CCP status.

FINANCIAL INCENTIVES BARRED: Contes-
tants must give to the committee satisfactory
assurance that they have not received, directly
or indirectly, any remuneration or promise of
remuneration of whatever character for enter-
ing or winning any part of this contest.

ENTRY FEE: Please register on  the Great Lakes
Regional Convention registration form. The fee
as stated on the regis-
tration form shall be
paid by the registration
deadline. Fee to be paid
prior to contest.

SEATING ARRANGE-
MENT: Seating shall be
at the discretion of the
chief examiner of the
Realtime Contest.

QUALIFYING: Only one
transcription will be
permitted of each test. 95% and higher quali-
fies. In order to qualify, contestant must write
realtime into a computer and, without editing,
at the direction of a testing monitor, create an
ASCII/text file on a 3.5” diskette, CD, or
jump/travel drive. Those unable to produce such
a file on a disk, CD, or jump/travel drive within
five minutes of such request may be disquali-
fied, at the discretion of the contest chair. After
verification of ASCII file, contestant will be
required to delete all components of the file,
including audio, from hard drive and recycle
bin. Realtime may be in either ALL CAPS or
mixed case. No transcript will be eligible for
consideration with less than 95% accuracy.

AWARDS: Winners and qualifiers will be
announced during the Annual Conference business
meeting and awards session.Medals will be award-
ed for first, second and third place, and an appro-
priate certificate to those who attain 95% or high-
er. The contest committee will publish/announce
only names of qualifying contestants. CEUs: Per
NCRA, qualifiers are eligible to receive .4

CEUs. An individual may only receive a maximum
of .5 CEUs per 3-year NCRA cycle for any contests. 

ALL COMMITTEE DECISIONS FINAL: The
decisions of the committee made under these
rules, or such supplementary rules as may be
found necessary at the time of the contest, shall
be final.

CONTEST MEDIA: All submitted disks, paper
notes, and printed transcripts become the prop-
erty of ILCRA and will not be available for par-
ticipant review.

GRADING: Contestants will not be permitted to
be present during the grading process. Tran-
scripts will be marked for identification and
corrected in such a manner that it will be

impossible to know
whose work is being
examined until after the
grading has been com-
pleted. A check-off list
shall be maintained
indicating the submis-
sion or non-submission
of a disk from each con-
testant.
ERRORS: Errors shall be
determined by the cur-

rent “What is an Error?” handout of NCRA
realtime skills testing.

Incorrect or missing punctuation: Tell me what
you did sir. (half point off). 

Incorrect capitalization: I telephoned Mrs. stone.
(half point off)

Untranslates or phonetics that are probably read-
able (by a layperson): I had an ace of /HARTS.
(half point off) But she had an ace of /TKAOE-
UPLDZ. (one point off) Her name was sinder
ella. (half point off)

Wrong homophones: Did you eat the plumb? (half
point off) I herd the doorbell ring. (half point
off) Did you eat the /PHRUPL? (one point off)

Incorrect compounding or spacing: She grows
roses in a regular green house. (half point off)
The car would breakdown often. (half point off)

Word or words otherwise misspelled but can be
deciphered or understood by a layperson: Did
the rabbit eat the care ot? (half point off) Did
the rabbit eat the indicator? (one point off) 

Conflicts showing up will be a full point off: Was
[there/their/they’re] any cake left? (one point
off) Yes, but [I/eye/aye] couldn’t see how much.
(one point off)
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ILCRA Announces Annual Realtime ContestILCRA Announces Annual Realtime Contest

Register for the ILCRA Realtime and/or
Speed Contests on the Great Lakes

Regional Convention registration form to
be mailed in May. All contestants for the
ILCRA Speed and Realtime Contests will
also be automatically competing for the

Great Lakes Regional Speed Contest and
Realtime Contest at no additional charge!

www.greatlakesconvention.com

http://www.greatlakesconvention.com
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CREATE YOUR OWN
NEWSPAPER

Q. I’m a news junkie and
though many sites permit me to
customize the type of news I
want, I was wondering if there
is any way to pull together
news from various sources so I
can just go to one place and see
my favorite news items? 

A. One of the oldest news
sites on the Web is one that
does permit you to do that in a
clever way, and for free. The
site is called CRAYON
(www.crayon.net). The name is

an acronym derived from CRe-
Ate Your Own Newspaper.
After registering on the site, go
to Your Paper’s Settings where
you can name your publication,
give it a motto, select the page
layout, graphics, and then
select your news sources from a
vast array of publications, news
media, by topic or other crite-
ria. Once you’ve made and
saved all your selections, log-in
and click “Read My Paper.” It
will be assembled and present-
ed to you faster than you can
holler, “Extry! Extry! Read all

about it!” If you’re a news
junkie, be sure to check out
www.newser.com, also.

Q. When I click View >
Details in a folder, is there any
way I can keep that view so I
don’t have to re-select the
Details view again with the
next folder?

A. Theoretically, Windows
will remember the View select-
ed for each folder and will dis-
play it the same way each time
the folder is opened. The opera-
tive word in the previous sen-

(Continued on page 27)

by Richard A. Sherman

Like the Wheel, Our Software Didn’t Need to be Reinvented.
(Come see SmartCAT for Windows w/Bonus features... but only if you want to use them)

w w w. c h e e t a h i n t e r n a t i o n a l . c o m   •   1 . 8 7 7 . 3 3 3 . 2 2 8 7

 

http://www.cheetahinternational.com
http://www.crayon.net
http://www.newser.com


tence is “theoretically.” Some-
times Windows remembers,
sometimes Windows doesn’t. I
can relate.

You can encourage Windows
to remember your View settings
by first configuring a folder the
way you want it to appear.
Then, go to the Control Panel >
Folder Options > View tab. For
versions of Windows prior to
XP, look at the list of options in
the Advanced Settings section
and locate “Remember each
folder’s view Settings.” Click to
place a check mark in front of
this option, then click Apply >
OK to save and exit. XP users,
click the “Apply to All Folders”
button, followed by Apply >
OK.

Vista users, go to the Control
Panel > Appearance and Per-
sonalization > Folder Options >
View tab and click the “Apply
to Folders” button. A less click-
intensive method with Vista is
to click the Start button and in
the “Start Search” field, type
“folder options.” Click Folder
Options when it appears as a
search result and you’ll be
transported to the Folder
Options dialog box.

Q. I’m divorced, but my
married name appears in the
From: field of email that I send
using Outlook. I can’t figure out
how to change the name people
see when I send messages. Can
you help, Mr. M?

A. You can easily change the

name that identifies you as the
sender. The process is the same
for both Outlook and Outlook
Express: Click Tools > Accounts
> Mail tab. If you have more
than one email address, you
will see them displayed in a list.
If you only have one, it will be
the only one displayed. (When
it comes to stating the obvious,
you can count on Mr. Modem.)

Click to select the account
you want to change, then click
the Properties button. The cur-
rent name displayed on your
email will appear in the Name:
field, which you can edit to
reflect your new name — or old
name, as the case may be. When
you’re finished, click Apply >
OK to save your changes.

Ask MrAsk Mr. Modem. Modem
(Continued from page 26)

AD INFINITUM Spring, 2008 Pg. 27

 
 
 
 
Are you looking for a great place to work? 
Cuda Reporting Service provides a friendly and professional environment.  We are a 20-
year-old firm with strong clientele and a great reputation. We are seeking enthusiastic and 
hard-working court reporters.  We promote teamwork and technology. We strive to 

provide the best support possible to help maximize your earning potential. If you are a 
new court reporter, we provide the training you need to really make the most out of your 

profession.   
 
For more information, please contact Peggy at (312) 236-6926 or email 

Peggy@cudareporting.com 
 

Cuda Reporting Service, Ltd.
205 West Randolph Street, Suite 610

Chicago, Illinois 60606
312-236-6926



THE AMERICAN ROADSIDE This site is
bumper-to-bumper full of entertaining road-
side attractions, interesting destinations
along scenic routes,  and wonderful old
“meat-loaf-and-taters” diners. Read articles,
view the photo gallery, or buy books, t-shirts,
and other American Roadside paraphernalia,
all destined to end up in your junk drawer.
www.theamericanroadside.com

ABOUT BIG NUMBERS Have you ever won-
dered how big an octovigintillion is? How
about a tredecillion, or a quattuordecillion,
or a million-jillion, or perhaps a penicillin?
There are so many big numbers here that
you’ll have a splitting headache in no time.
http://tinyurl.com/yslq65

BRAIN TRAINING BRAIN METRIX advises us
that when it comes to our neurons, “use ‘em or
lose ‘em.” To help keep the ol’ brain cells stimu-
lated, BrainMetrix provides an assortment of
cerebral games and exercises that will keep our
minds sharp for… for… well, perhaps it’s too
late for me, but hopefully it won’t be for you.
Give your gray matter a vigorous workout by
participating in any of a number of these mind-
training exercises. http://brainmetrix.com

Mr. Modem’s weekly newsletter delivers easy
computer tips, great Web sites and personal
answers to your questions! Trial offer: Subscribe
online using Promo Code 1146 and receive a free
month with your 6-month subscription (28
issues!) To view a sample issue or subscribe, visit
www.MrModem.com. 

MrMr. Modem’. Modem’s DME s DME 
(Don’(Don’t Miss ‘Em) Sites of the Montht Miss ‘Em) Sites of the Month
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Lookin 

SULLIVAN’S LAW DIRECTORY® 
Serving the Illinois Legal Community Since 1876 

 
Looking for more exposure for your business? 

Sullivan’s Law Directory® has just what you’re looking for. 
 
 
 
 
 
 
 
 
Don’t just take our word for it - ILCRA Members say it best: 
 
“For years I’ve received great referrals as an advertiser. As a Court Reporter, 
it has helped immensely in obtaining contact information as well as spellings.” 
Marian Vahl, Vahl Reporting, Waukegan, IL 
 
“Our reporting agency has advertised with Sullivan’s for the past 10 years, and 
we are quite pleased with the increase of business we have seen over those years.” 
Lucinda Uphoff, Advantage Reporting Service, Peoria, IL 

3-line court reporter 
listings are just $280 and 

include a free copy  
of the book! 

Call today for more info. 
1-877-556-0719 
(ask for ext. 4012) 

Here’s what makes Sullivan’s the obvious choice when advertising: 
 
◊ Over 26,00 copies sold each year (they buy it because they use it) ◊ Readership of over 100,000 
◊ Targeted specifically to the Illinois legal profession   ◊ Full year shelf life for your listing 

http://www.theamericanroadside.com
http://tinyurl.com/yslq65
http://brainmetrix.com
http://www.MrModem.com
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NCRA FILES BRIEF IN OHIO
PAYMENT CASE

NCRA and the Ohio Court
Reporters Association partnered
on an amici curiae brief in a
state court case wherein an
attorney has refused to pay a
reporting firm’s invoice on the
grounds that the attorney’s
client is the responsible party.
The brief indicates that Ohio
courts have generally held that
“in the absence of express notice
to the contrary, court officials
and persons connected with the
progress of the litigation may
safely regard themselves as deal-
ing with the attorney.” The
question of who is responsible
for court reporters’ fees is a mat-
ter of state law, and the answer
varies from state to state.

The brief notes that Courts
historically applied principles of
strict agency to the question of
liability for court reporting fees.
The attorney requesting services
from a court reporter was
regarded merely as the client’s
agent in the transaction, and the
client, as principal, was liable
for payment. Thus developed the
historical rule that an attorney
is not liable for the court
reporter’s fees unless the attor-
ney expressly assumed liability. 

As litigation has evolved,
however, the roles of attorneys
and court reporters have
expanded and changed.
Although the historical rule
may have been suitable in the
nineteenth and early twentieth
centuries, it is unable to accom-

modate the realities of modern
litigation. The modern attorney
is no longer a mere agent of the
client. The brief cites 20 cases
and seven state statutes relating
to the issue.

ATTORNEY, CLIENT FINED
FOR DEPO BEHAVIOR

Fans of decorum in legal
proceedings can rejoice. The
March 5 Legal Intelligencer
reports that a federal judge has
fined an attorney and his client
nearly $30,000 for abusive
behavior, vulgar language, and
uncooperative responses to
questioning during a deposi-
tion. In reviewing the transcript
and a video of the deposition,
the judge found that the depon-
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ent dropped no fewer than 73
“f-bomb” variations, several
involving personal characteri-
zations of opposing counsel.
Deponent’s attorney was sanc-
tioned for failing to control his
client’s behavior.
WHEN ER COMES KNOCKING

When electronic recording
(ER) comes knocking, do you
have a plan? NCRA has heard
from their members that many
do not. In response to their pleas,
NCRA has created a Warning
Signs reference guide so that you
know what to do when ER
threatens your position in the
official or freelance setting. This
reference guide includes the top
10 warning signs that ER is
encroaching on your market-
place and the top 10 reasons

your key decision-maker (judge,
court administrator, or attorney)
should utilize a court reporter.
Finally, the document includes
what to do if your area is being
threatened by ER. This informa-
tion was compiled by NCRA’s ER
Task Force to help ensure that
you, as a member of NCRA, are
not alone when facing the ever-
changing and competitive mar-
ketplace. These Warning Signs
may just help you, a friend or a
coworker keep your job down
the road. So share this informa-
tion; don’t sit on the sidelines
and wait for ER to hit you.
DIGITAL SIGNATURE 
V. ELECTRONIC SIGNATURE —
WHAT’S THE BIG DIFFERENCE?

This article discusses the dif-
ference among digital signature,

electronic signatures, and PKI,
and the possible misconceptions
behind the usage of the terms.
As the author notes, the terms
digital signatures and electronic
signatures should not be used
interchangeably.(www.silanis.com/
resource-center/articles/electronic-
signatures-vs-digital-signatures.html)
E-LOCK TECHNOLOGIES
LAUNCHES INSTASIGN, FREE
ONLINE DIGITAL SIGNING
SERVICE

InstaSign is designed to
provide easy-to-use digital sig-
natures, replacing physical
ones. According to one of the E-
Lock co-founders, instaSign
will enable users to access digi-
tal signatures at any time free
of charge.(www.elock.com/pr-
instasign.html).
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THE WITNESS OBJECTS!
ASSISTANT STATE’S ATTOR-

NEY: At this point, Your
Honor, we would ask the
Court to recognize the witness
as the defendant — I mean, as
an expert. 

THE COURT: Any objection?
DEFENSE ATTORNEY: No.
THE WITNESS: I object. I don’t

want to be a defendant.

TAKE IT OUTSIDE!
DEFENSE ATTORNEY: I didn’t

get it. That’s the type of —
that’s what the State has done
throughout this trial.

STATE’S ATTORNEY: If Mr. X
is going to accuse me of
unethical behavior, can he
please put it in the form of a
motion? 

DEFENSE ATTORNEY: I am
not accusing you

STATE’S ATTORNEY: That’s
exactly what you are doing,
through the course of the trial,
and we are going to have more
than words if you continue.

—Submitted by 
Amy B. Haught CSR, RMR, CRR

Immediate Past President

ILCRA OFFERS 
ONLINE MENTORING

If you are student who would
like an online mentor; or a
court reporter who is interest-
ed in becoming an online men-
tor, go to www.ilcra.org and
click on the online mentoring
link, or just click here. 
It’s that easy!

CCOOUURRT FT FUUNNNNIIEES!S!

NOTICE: 
There will not be a Call for
Nominations for the ILCRA
Executive Board this year.
This is due to the bylaws
changes enacted last year.
Call for Nominations will

only be every two years and
will next occur in 2009. 

STOP BY FOR A ‘VISIT’

VVisit the ILCRA forum
at www.ilcra.org and

read any of the threaded
messages, reply to any of
the threaded messages with
your own message and/or
start a new thread with a
message of your own!

w w w. c h e e t a h i n t e r n a t i o n a l . c o m   •   1 . 8 7 7 . 3 3 3 . 2 2 8 7

Of Course You Waited, Now it’s Time to Move.
(Come see SmartCAT for Windows w/Bonus features... but only if you want to use them)

http://www.cheetahinternational.com
http://www.ilcra.org
http://www.ilcra.org
http://www.ilcra.org
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WHAWHAT ILCRA DOES FOR ILLINOIS REPORT ILCRA DOES FOR ILLINOIS REPORTERSTERS
• Works to maintain your right to be certified.

• Administers the RPR, RMR, RDR, CRR, CBC, and CCP
examinations and publishes the dates of the tests
in Ad Infinitum.

• Monitors, promotes, and lobbies to pass legislation
favorable to the interest of court reporters, captioners
and CART providers. Monitors legislation affecting our
professions on a statewide and national basis through
both our Legislative Committee and our lobbyist.

• Sponsors an annual two-day conference and one-day
seminars including continuing education and the lat-
est in reporting technology. 

• Co-hosts and pays for NCRA continuing education
units for the three Court Reporting Services
Seminars. ILCRA also provides personnel in connec-
tion with those continuing education credits.

• Publishes the Ad Infinitum, a quarterly online newslet-
ter containing the newest up-to-the-minute reporting
developments throughout the state, highlights of
board meetings, advertisements of vendors and
agency owners, and names and telephone numbers
of ILCRA officers.

• Serves as an affiliated state unit of the National Court
Reporters Association.

• Offers members significantly reduced rates for the
conventions and seminars.

• Provides on the ILCRA website, a membership direc-
tory which includes the CSR Act, Court Reporters’
Act, Rules and Regulations of the Illinois Department
of Professional Regulation, Transcript Act, and ILCRA
Bylaws, as well as member information.

• Awards a Student Scholarship, a Distinguished
Service Award, an Award of Excellence for an
Outstanding Educator and conducts speed contests
each year.

• Offers an Online Student Mentor Program.

• Promotes student recruitment.

• Organizes letter-writing campaigns on issues affecting
our professions.

• Sends representative members to legislative boot
camps, leadership conferences and the national con-
vention for training and education.

• Provides reporters for demonstrations on request and
attends career days throughout the state.

• Provides a court reporters network through our
ListServe program which allows ILCRA to immediately
be in touch with members via e-mail.

• Serves the membership with an 800 phone number,
1-800-656-2467 and a website www.ilcra.org.

• Provides a full-time staff person, our Executive
Director, to assist members.


